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Programming the XBT-M terminal

5.1

Summary

of operation

The XBT-M is a message box type terminal fitted with a fluorescent matrix display
with 128 x 20 pixel resolution.

This terminal has a protected integral clock and a serial printer link. It can control
the display of messages by discrete inputs and has an operator guide function
controlled by three pushbuttons.
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can be disconnected when
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Summary of operation

Many types of display are possible and various sizes can be used. It is possible to
scroll the message and use symbols set by the operator.
The XBT-M terminal can also display the value of variables in the form of
histograms.

DISPLAY
CAPACfTY

l

l

l
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DOUBLE
WIDTH

SINGLE
SIZE
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TzzCVV--z%
Al.
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LIFT SPEED 1.1~~‘s
1357 Ks 7 5387Mm

1 line of :
10 characters (h = 20 mm)
scrolling of 42 characters

1 line of :
21 characters (h = 20 mm)
scrolling of 84 characters

2 lines of :
10 characters (h = 10 mm)
scrolling of 42 characters/line
l

l

2 independant lines of :
21 characters/line (h = 10 mm)
scrolling of 84 characters/line

l

l

DOUBLE
WIDTH

ELE’UR
’ TORT
LIFT SPEED I. lm/s

SINGLE SIZE

2 lines : Display combination of
double width and single size
characters

L

In addition to these functions the XBT-M terminal has an internal memoryforstoring
the displayed messages. The contents of this log memory can be printed at a
command from the operator or the control system.
The displayed messages may come directly from the control system linked to the
terminal or can be called up from the terminal memory cartridge.
Its functions can be summarized as follows :
- data sources (integral memory or control system)
- destinations (display unit, log memory, printer)
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Using

simple

rermlnal

of operation

functions

:

A command initiates an action.

l

Using

compound

functions

:

A command initiates several actions.

l

Control

system

command

XBT-M terminalssupportthreetypesofserialcommunication(RS232C,
RS 422/485,
current loop) and can communicate using ASCII, ADJUST (Telemecanique) or UniTE (Telemecanique) communication protocols.
A 12 input parallel link is available for connecting to the discrete outputs of a control
system and commands for the serial and parallel ports can be used simultaneously.
For further details on the functions of XBT-M terminals, refer to the guide “XBT-M :
Multifunction matrix display” (ref. XBT XM800E).
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5.2

Application

l

-

development

using XBT-L900

Developing a new application

The XBT-M message box hasalarge number of functions and provides sophisticated
operator dialogue. The complexity of developing an application for an XBT-M
terminal using XBT-L900 software is dependent on the functions required by the
application.
The entire method using all the terminal functions is described here.
Analysis of the application must enable a certain number of parameters to be
defined, for example :
- communication protocol used
- creation of a special character font set
- use of macro-messages
- use of the operator guide
- number of application messages

b

The number of messages used determines the size of the memory cartridge
required for the application, taking account of the fact that XBT-L900 V 1.3 allows
the size of the message list and therefore the associated memory cartridge to be
modified during development.
The application development method consists of performing the following steps :

Creating a special
character font set

Creating a
message list

Creating
macro-messages

a
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Application development using XBT-L900

Creating an
operator guide

Configuring
the terminal

Saving the
application

Transferring the
application

Printing the
application dossier

Naturally, the user should ignore any step corresponding to functions not used
(special character font set, macro-messages, operator guide).

l

Retrieving applications created using XBT-L900 V 1.2

Application files created using XBT-L900 V 1.2 can quite easily be retrieved in local
mode. The work directory for the old application should be selected and the old files
worked on. Changing the work directory in the “Character font set” function is also
valid for lists of messages and enables an old version to be modified transparently.
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5.3

Creating the user’s own font

The font set supplied with XBT-L900 V 1.3 for XBT-M terminals has 224 characters
and is entitled defaut .xfn. If the user does not find the graphic or special characters
he requires, it is possible to modify one or morecharacters in this font set or to create
a new set using the default character font set as a basis.
The method of creation is verysimple.The operator uses a grid of dots representing
the character to be drawn and can draw the character pixel by pixel.
The creation procedure is as follows :
Select the XBT-M terminal from the main XBT-L900 window.

XBT-M8

*

,+.:<.:.:.v,.

..p.e

1

:‘.<.,,

x.:.,<.:.:.:.:.

‘.<

- Access the font set window : click on the font set icon :

- Open a font set :
for a new font set : click on “New”
for an existing font set
‘
: select the font set then click on “Open”.
This accesses the character editor. First select the character to be modified using
the scroll bar and the mouse.
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Characters can be drawn in single size or in double height, but they can be used
in four authorized modes :
- single size
- double width
- double height
- double size
When creating a symbol needing more pixels it is possible to place several basic
symbols side by side to create a macro-symbol (see example).

l

0 Single Size

Single size : 6 x 8

0 Double Height

Double height : 6 x 20

Entering I modifying a character
To modify a character, proceed as follows :
- Select the character resolution : Single size or Double height.
- Bring the character into the window by using the scroll bar.
- Select the character you wish to modify by clicking higher up, in the window
located above the scroll bar. It then appears in reverse video.

Using the grid, it is possible to modify each of the pixels which make up the
character. To modify a pixel, click on it. To make the same modification to several
pixels, click on the first pixel, then drag the mouse over all the other pixels you
wish to modify, holding the mouse button down. Release the button once all these
pixels have been modified.
It is also possible to use the tools (available in the window) to perform certain
operations on the selected character, or on the complete font set.
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l

Tools available

These commands are available in the “Tools” menu in the window.

Expand

character

0 Single Size
o IDouble..Heighti
... ...................... .......... .......
t‘,

Grid : toggles the appearance of the grid in the character modification window
Delete : the selected character is replaced by a blank character (all its pixels
are white)
Invert : the selected character is changed to reverse video (each black pixel is
replaced by a white pixel and vice-versa).

Restore : cancel the last modification made to the selected character.
The next two tools are only available in Double Height resolution on the XBT-M :

_ Expand character: automatically draws the selected character, based on the
same character previously created in Single Size resolution.
Use to :
Change to single size,
Create or modify a character,
Change to double height,
Select the Expand character command.

P

_ Expand font set : automatically draws each character in the font set from the
same character previously created in Single Size resolution.
Use to :
- Change to single size,
- Create or modify any characters in the font set which you wish to change,
- Change to double height,
- Select the Expand font set command.
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When a symbol is created, it can be displayed in the four display modes and can
therefore be used in messages of various sizes.
Example of the display of a symbol created in single size and expanded to double
height.

l

Macro-symbols

As there are no inter character spaces, “macro-symbols” can be created in any
display mode by placing characters side by side.

USING
MACRO-SYMBOLS

SINGLE SIZE

l

Saving the font set

The font set is saved either by clicking on the diskette icon of the main XBT-L9Or
window, or by closing the font set window.
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5.4

Creating the message

list

To create a message list, start at the main XBT-L900 window (XBT-M terminal
selected).
- Main window with XBT-M terminal selected

- Create a message list : click on icon
The window for opening a document appears.

enel.xtx

Directory :

m8.xtx
pruelsaxbc
sollacxbc

I-1
[alsth.app)
ItmPl
Ivm8.aPPl
[xbtl900]

c:bbtl900
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New message list

In the window for opening a document :
Click on “New” to create a new application or to open an existing file.
After clicking on “New”, a window called “Message list size” appears :

0

4 Kb [lOO Messages]

0

16 Kb [400 Messages)

@

24 Kb [600 Messages]

0

56 Kb [1400 Messages]

0

88 Kb [2200 Messages]

A 24 K cartridge is selected by default. This cartridge corresponds to a list of 600
messages. When there is sufficient information about the application, a different
cartridge size can be defined. The command “Modification of message list size” is
used to change the size of the cartridge.
Warning:
The size of the message list may be limited by the memory available for Windows
in the PC. If there is insufficient memory an error message appears and a smaller
size must be selected, or more memory freed for Windows.
If there is insufficient memory to open an existing message list (file . xtx), the same
error message appears and more memory must be freed for Windows.
If the size options in the “Message list size” window are greyed out, the size of the
message list cannot be selected due to lack of memory available in Windows.
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After clicking on “Ok” or opening an existing file, the “message list” grid appears

:

Example : Sollac.xtx
Options

~

This list comprises the following parameters :
NUM
TEXT
TYPE
X
Y
A
C
V
F
R
s
G
U
W
w

allows a number to be associated with the message, and the number
to be called up by a command from the control system
message text (21 single size alphanumeric characters) or length of
the histogram
message type (V = fixed display, D = blinking display, H = histogram
display)
position of first character of message in the display unit (OrX284), X +
message length < 84
Select the display line (Y = 1 or 2 according to the size of
characters (Y = A,B,C,D or E for histograms)
Confirm parameters for updating the variables (A = 1 with updating,
A = 2 without updating)
variable conversion coefficient (0.001 5 C I 1)
Associated TSX 7 variable, in Uni-Te or ADJUST protocol
size of message and histogram display (F = 1 double height display,
F = 2 double width display, F = 3 double size display)
Number of network to which the PLC is connected
Station number (PLC address)
Gate number (Uni-Telway addressing)
Module address (slot in the I/O rack)
Channel number (Uni-Telway device address)

For further details on using message parameters in an XBT-M terminal, refer to the
user guide “XBT-M : Multifunction display” ref. XBT XM800E.

67

Programming the XBT-M terminal

5

Creating

l

the message

list

Entering data
- The various parameters can be entered using the mouse and the keyboard
- The parameter to be entered is shown in bold
- To move around the grid, click once on the selected parameter
- To move around using the keyboard use the arrow keys, +, T, 1. Confirm
selection of a message parameter by pressing a.

Important :
Once a message parameter has been selected, entering a single character will
delete the whole of any message field and allow a new message to be defined.
To modify an existing message, the cursor must be placed at the end of the
message by pressing F2 or the (0) key (deletes the preceding character).
Any message definition or movement is then performed from the cursor position.
A syntax check is performed on each parameter, and it is not possible to proceed
to the next parameter until the current parameter has been correctly constructed.
Moving from one line to another can only take place if the defined message is
coherent. If not, a message is displayed which tells the operator the source of the
error.
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When using the keyboard, confirming the final message parameter automatically
brings up the next message.
Notes :
l

l

The operator can call up the “Help Menu” (on-line system help) at any time
for details concerning the window in use.
For information about the significance, the limits and the use of any parameters
associated with a message, refer to the user guide “XBT-M : Multifunction
matrix display” ref. XBT XM800E.
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Selection of the font set (only possible with the mouse)

One of the main advantages of the XBT-M terminal is that the matrix display can
display ASCII messages and symbols at the same time. These symbols must be
created using a special font set which has been saved.
In the message text field, it is possible to use characters which cannot be accessed
from the keyboard, or to use characters in a font set which has previously been
created (see Section 5.3).
The XBT-M supports a default font set of 224 single size characters and a default
font set of 224 double height characters (both these font sets are stored in the same
file).
- When parameter F of the selected message is 0 or 2, the single size font
set is displayed.
- When parameter F of the selected message is 1 or 3, the double height
font set is displayed.
When a font set or special character is used in a message, the font set used to
display the message can be selected.

w
The “Options” menu in the message list window accesses selection of the font set.

lnitialise

cartridge...

This function enables special user-defined characters to be used in a message. The
defined font set is the same for the whole message list.
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Selecting the font set :
Click on the -1
the required font set.

button in the active “Font set” window, then select

Title of active font
set
\

Font set
selection
\

WCDEFGHIJKLMNOPQRSTU

Message

Left

:

Translaticm

Select the .xfn file containing the font set to be used for display of messages

font1 .xfn
font2.xfn

Directory :

14
-c:“
:

c:~btl900\alsth.app
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The font set window appears :

Zoom of message currently being edited.
Scroll bar for the selected font set.
Window displaying characters for selection/entry.
Selection of font set.
Current message.

Entering characters in the displayed font set :
With the Message list and active Font set windows both open :
- Click on message field F and select the format in which you wish it to be
displayed.
- Click on the message text field.
- Type in the characters which can be accessed from the keyboard (these
appear in the zoom of the active Font set window).
- Click in the active Font set window.
- Use the scroll bar to bring the required character into view.
- Clickon the required character, which then appears both in the zoom, and in
the text field of the message list.
- Click again in the message text field.
_ TYPE F2 BEFORE CONTINUING TO ENTER FROM THE KEYBOARD.
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Comment :
Characters which cannot be displayed by the microcomputer show up as black
squares in the message text field. To see how it will actually look, leave the active
Font set window open, and click on the message text field. The message appears
in the zoom window exactly as it will be displayed.

Confirming the active font set
When a special font set is selected in the message list to be used for one or more
messages, the last font set that has been used is confirmed.
The XBT-M only manages one 224 character user-defined font set. This means that
all the active symbols-in an application must be located in the same font set.
This font set is transferred to the XBT-M when the message list is transferred.

Saving the message list
The message list is saved on closing, or by clicking on the diskette icon of the main
XBT-L900 screen.
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5.5

Creating macro-messages

A simple message in the message list has a display field of 21 single size
characters. Sometimes data or operator instructions above this size have to be
displayed.
In this case, the XBT-M terminal can use an 84 character display buffer to manage
a function for scrolling the messages, which can link the messages together to
make up a macro-message.
Creating a macro-message :
The message list should be open and completed with the messages which are to
be displayed. A macro-message is made up of a string of messages (8 maximum)
linked together by their numbers.
To create a macro-message, select the first message in the macro-message in the
message list (eg : message N”4). Open the macro-messages window using the
“Options” menu in the message list and the “Macro-message” command.

Configuration...
Font set...

Default messages...

1 Coeff

1 Uar.
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The “Macro-message” window appears with the number of the selected message.
This window has 4 commands which are used to create the macro-message.

Add
Select from the message list the next message to be added and click on “Add”.
This selection is made using the mouse on one of the fields in the message.

The macro-message is constructed in this way, with up to 8 messages (size of the
macro-messages window). The “Add” command enables a message to be inserted
into a macro-message using the following procedure :
- select the message to be inserted from the message list
- select the number of the message in the macro-message window after which
the additional message is to be inserted
- click on “Add”
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Previous
This command checks that the first message in a macro-message
selected, while the macro-message is being displayed.

has been

Example :
- message 5 in the message list is selected, the “Macro-message” window
is open, the “Previous” command shows that the macro-message does not
start at 5.

Previous messages :

- Close the “Macro-message” window, select message No4 in the message list,
open the “Macro-message” window, click on “Previous” and see that the
macro-message starts at 4.

Previous messages :

.,._..._......:.....:.....:..
CONUEYOR

BELT

2”“‘.

.,,,,,_._.....:.....:.....:..
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Delete
To delete a message from a macro-message, select it in the “Macro-message”
window, and click on “Delete”. If this message is not the last one in the macromessage, a link with the following message is created.

Example :

Deleting message N” 2

Select the message to be deleted

The selected message is deleted.

The new macro-message starts at message N”4, contains message No5 and ends
at message N”7.
Warning :
Deletion cannot be undone. If a mistake is made, the”Add”command
to insert the deleted message.

must be used
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This command enables a new macro-message to be created using the following
procedure :
- select the first message of the macro-message to be created from the list
of messages
- click on “New” and create the associations using the “Add” command
The “New” command also enables existing macro-messages to be displayed.
When a message number in the message list has been selected and “New” has
been clicked on, the message will appear in the “Macro-message” window if it is
already a macro-message.
If this happens, check that it is the first message in the macro-message by using the
“Previous” command.
l

Saving macro-messages

The macro-messages are finked to the open message list.
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5.6

Creating the operator guide

The operator guide is a structured set of messages defined during the creation of
the application. It is intended to help the operator. Special keys are used to move
around the message tree structure, or to implement necessary actions under the
control of the control system depending on how far advanced the process is.

Operator guide structure
The operator guide comprises messages or standard macro-messages from the
message list with two additional parameters (Item and Level). These create the
links between the messages which make up the operator guide.
When creating the operator guide, it is useful to display these links to create the
structure of the operator guide.
ITEM
N”

TEXT + PARAMETERS
LEVEL

When creating the operator guide using XBT-LSOO, the Item and Level parameters
are automatically calculated by the software as a function of the structure defined
for the operator guide. The links between messages are automatically created by
the software.
Three pushbuttons, or commands transmitted by the control system, are used to
enter or move around the operator guide. For clarity in the following examples, the
pushbuttons are used. The result is identical to the commands transmitted by the
control system.

Example of operator guide structure :
level 0
300

level1
310

level 2
329

c-i

+ @

PROCEDURE
CHECKS

0
ELECTRICAL
CHECKS

(ENTER)

310

item 1

lb:,
pg

@(l40/

Y
Y

@
CHECKS
MECHANICAL

H

@b3’

1

47
level 3
340

item2
CHECK
ISOLATION

vsouLpTpALGyE tq

HYDRAULIC
CHECKS

3.41
Y

0

341

PO:%:,,

ACTIVATE
DEFLECTOR

TEST
FLANGE

14

48
w

POSITION
FEEDER

t
#
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The operator moves around the operator guide either horizontally on one level item
by item or vertically level by level.
The following commands are used to move around:

ENTER

!

I

At the ITEM or LEVEL
message which = *

o+o

0

CANCEL
NEXT ITEM

0

I

1 Cancels last operation

1

Move to last possible
item

I

j t$;;z

NEXT LEVEL
PREVIOUS LEVEL

COMMENT

OPERATOR ACTKWS

GUlDE ACTfGffS

)

@

+ e.

/

0

+

@

0

= 0

last level

j CanretumtolevelO

/ From level 0

For further details on using the operator guide, refer to the user guide “XBT-M :
Multifunction Matrix Display” (ref. XBT XMBOOE) Section 1.7.
l

Entry of operator guide

Entry of the operator guide comes after entry of messages and macro-messages.
The operator guide editor is accessed by the “Options” menu in the “Message list”
window.

/
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Creating the operator guide

The first message in the operator guide should be selected from the message list
using the mouse, then the structure of the guide is created using the “Add H” or
“Add V” commands.
The next message is then selected from the message list, and it is entered in the
operator guide in the same way.
The same procedure is used for all messages in the operator guide.
The first message in an operator guide can only have one link.
Messages are represented in the guide by a box containing the number of the
corresponding message. Messages are selected by clicking on them with the
mouse. The selected message appears in reverse video and it is at this point that
the commands “Add H”, “Add V” and “Delete” are available.
When a branch of the operator guide cannot be represented on screen (overlapping
with another branch), the access arrow is greyed out. To make the missing branch
appear, double-click on the box containing a greyed out arrow.

A message that is already used in the operator guide or is part of a macro-message
is represented by a shaded box. The “Add H” and “Add v” commands do not work
on this type of message.
These three commands are used to create the structure of the operator guide :

This command enables the operator guide to be extended horizontally. It adds
horizontally (Item) the messageselectedfrom the message list to the operator guide
which is being set up.
IAdd
-> LEVEL
This command enables the operator guide to be extended vertically. It adds
vertically (Level) the message selected from the message list to the operator guide
which is being set up.

This command deletes the selected message from the operator guide which is
being set up. Warning : this operation can wipe out an entire branch of the operator
guide and cannot be cancelled.

80
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Using macro-messages in the operator guide
Macro-messages can be used in the user guide. A macro-message is represented
by its first and its last message, linked by a double arrow.

\
Macro-message
10 -> 12
The macro-message is selected from the message list by the number of its first
message. The commands used are the same as those used for messages.
A macro-message
message.

example :

in the operator guide is selected by the number of its last

@GjpBI

for the macro-message from 10 to 12.

To delete a message from a macro-message :
- Select it by clicking on its box
- Click on Delete.
Warning : this operation can wipe out an entire branch of the operator guide which
is directly linked to the deleted message.
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Displaying the operator guide
- Open the operator guide window.
- Double-click on the boxes containing a greyed out arrow. To view the whole of
the operator guide window, it may be necessary to use the scroll bars.
Saving the operator guide
Only one operator guide is linked to the message list.

Operator guide characteristics
The operator guide is available on XBT-M 80411 X terminals. Its maximum size is
12 levels and 93 items. Control system commands or pushbuttons linked directly to
the XBT-M terminal, and activated by the operator, are used to move through the
items and levels.
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5.7

Configuration - Messages displayed by default

l

Configuration

v
Configuring the XBT-M terminal enables the operating parameters to be set. For
certain parameters this configuration can be performed in local mode. Connection
to the XBT-M terminal is necessary to test the other adjustment parameters, such
as screen brightness.
Parameters configured in local mode
- Communication protocol used
- Configuration of the serial operating link
(link with the control system)
- Selection of the printing operation
- Configuration of the serial printer link
- Display language for the XBT-M terminal system messages
- Selection of messages displayed by default
- Configuration of the display unit
- Clock update

l

Accessing the configuration

The configuration isaccessed from the”Message list”window. Select “Configuration”
in the pull-down “Options” menu.

Eont set...
Operator Guide...
Macro-message...
Erase XBTM...
Qefault messages...
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by default

The “XBT-M8 configuration” window appears :

rDlSPlAY

CONFIGUFIATION

:
jm
~~~

:

Format

0 I

biis

0

~

II bi!s

0
AUXILIARY

LINE

:

LANGUAGE:

:

Prlntlng

FUNCTION

:

Speed

:

Format
Parity

:

Conn.

:

0

7 bits

Lest

lEngllsh
MODES

:

@ 8 bits

0 Rs232 modem
Terminator

q

:

OCR

UNI-TE address

@LFCR

printing

This window has 6 information blocks to be filled in.

Serial operating link configuration menu
- select the protocol (Uni-Te or ASCII)
- serial operating link parameters
Auxiliary line configuration menu (printer on XBT-M80411 X)

- printing operation
“With” printing authorizes the copying of messages and transparent printing
(refer to the XBT-M installation guide : Multifunction display unit ref.
XBT XM800E section 5.4, 6.4 or 7.4 depending on the protocol selected).
Select the “CR” terminator if the printer is configured for auto-LF, if not select
CR LF (line feed generated by the XBT-M terminal).
To print the UNI-TE address (Uni-Te protocol only) : click in the box to select
or deselect printing of the UNI-TE client address (station connected to the
XBT-M terminal where the terminal looks for the value of the variable).
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- Messages

displayed

by default

- serial printer link parameters
speed (from 110 to 9600 bauds)
number of stop bits (1 or 2)
number of data bits (1 or 2)
parity bit (even, odd or without)
RS 232 (No management of service signals, pins 2-3-7 only)
RS 232 Modem (Management of service signals for the RTS, CTS, DSR,
DTR data flow control, complete version of the RS 232 C cable)
To ensure correct printing these parameters must be identical in the
configuration of the printer used and in the XBT-M terminal.

Language selection menu
Select the language in which the XBT-M system messages will be displayed
(6 languages available : English, French, Spanish, Italian, Russian, German).

Compound function (XBT-M8041 IX only)
The operating modes menu is used to select the type of printing and saving.

FUNCTION

YIStorage
Time :
I

MODES :

and printing
.
.
12 .
1

- Simple
No message is printed systematically, all orders to print come from the
control system.

All messages displayed on the XBT-M terminal are systematically sent to the
printer (“With” printing in the configuration).

- Automatic saving
All displayed messages are saved to the log, and there is no systematic
printing.
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- Messages

displayed

by default

- Saving and printing
All displayed messages are saved to the log and systematically printed. This
mode corresponds to automatic saving and automatic printing.

Window

for adjusting

the date and the time of the clock

This function is used to adjust the date and time of the internal clock in the
XBT-M terminal. The date and time are initialized by the integral clock in the
PC when the window is opened.

Select the item to be modified and use the arrows to alter its value. The clock
in the XBT-M terminal is initialized to this value when the configuration is
transferred.

Window

for adjusting

the display

parameters

This function is used to adjust the legibility of the display according to the
conditions of use.
-DlSF’lAY
Blinking
Scrolling

CONFIGURATION

:

:
m

:

Brightness

m

:
0 lest

This window is used to adjust how quickly the lamps blink, message scrolling
speed and the brightness of the display. If the XBT-M terminal is connected
to a PC, pressing “Test” will immediately show the result of the modifications.
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displayed

by default

Messages displayed by default

The user can define one or two messages to be displayed by default on power-up
(if these two messages are not defined, the XBT-M displays “RUNNING” mode on
the first line and the time on the second line for XBT-M80411X).
Selection is accessed from the “Message list” window.
Select Qefault
‘
Messages” in the Qptions menu.
The “Messages Displayed by Default” window appears :

numbers into the terminal
Registers the default
message numbers
in the PC

are retained

To define the messages :
Click on the “Message 1” or “Message 2” entry zones, then enter the message
number using the keyboard.
The display parameters defined in the selected message (s) are implemented, in
particular the display format.

Warning :
When a message list or a configuration is transferred, this data is not sent to the
XBT-M terminal. To display the default messages when the terminal is powered up,
the default messages displayed must be “Exported” after the application has been
transferred.
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Saving the application

Saving an application consists of saving the two files containing the application
developed for the XBT-M to the PC disk (hard disk or diskette).
- the message list and configuration data
- the special font set defined by the user
Saving these files is always done in the same way, using one of three methods.
- select the “Save” or “Save as” commands in the “File” menu of the main
XBT-L900 window

- click on the diskette icon in the main
XBT-L900 window

- close the window by double-clicking on the system menu box

This method does not allow
the file name to be changed.

A document can be saved using its current name or it can be saved as a different
name.
The current name is the name of the document being worked on.
This name appears in the title bar of the window, after “Message list”.
Above example : sollacxtx
The “Save” command in the “File” menu of the main XBT-L900 window saves the
fileunderitscurrent name, withoutaskingforconfirmation.TheoldfileisoveMlritten
by the new one.
Double-clicking on the system menu box enables the user (after confirmation) to
close the window and save the modifications, to cancel the operation and leave the
window open, or to close the window without saving the modifications.
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Confirmation window :

C:V(BTL9OO~LSTH.AP~aIsth.xtx
save the modifications ?

has changed,

The directory and the name under which the file is saved can be changed by using
the “Save as” command in the “File” menu, or by clicking on the diskette icon of the
main XBT-L900 window.

Save As :
c:\xbtl900

alsthxtx

\
I
h

Current directory
Return to c: directories
Select directory
Select volume
File name
Confirm/cancel

a9
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Printing and transferring

l

the application

Printing

In order to print out an application a message list must be open. The printing
functions are accessed either by clicking on the printer icon (yellow) of the main
XBT-L900 screen, or by selecting “Print” in the “File” menu.
The application is printed in the following format by default :
- Configuration of communication link
- Message list
- Macro-messages and operator guide
It is possible to print only part of the message list by selecting the zone to be printed.
Use the mouse to select as follows :
- select the first message (click on the message number)
- drag down using the left hand mouse button until reaching the last
message required.
The following message appears during printing :

Send
alsthxbc
to spooler...

J

If a problem occursduring printing, checkthe printerconfiguration in the WINDOWS
configuration control panel (Main Group).
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the application

Transferring from PC -> XBT-M (Export)

The XBT-M terminal must be in “Running” mode and connected to the PC via the
serial link for all transfer operations. The configuration parameters of the
PC c-> XBT-M serial link are defined in the “Configuration” menu of the main
XBT-L900 window.
To transfer an application created using XBT-L900 to an XBT-M terminal proceed
as follows :
- initialize the cartridge (optional)
- delete the messages (optional)
- transfer the message list
- transfer the special font set
- transfer the configuration
- transfer the default messages

- Initializing the cartridge

w

New cartridges must be initialized. Otherwise this operation is to initialize the
memory and ensure that the application only contains the elements transferred
after initialization.
The operation is executed by the “lnitialise Cartridge” command in the “Options”
menu in the message list.
- Deleting messages

/

This operation deletes the contents of the stored message list from the XBT-M
terminal memory. If the open message list is smaller then the XBT-M terminal
cartridge, there is a partial deletion limited to the message list. The messages to be
deleted can be selected from the message list using the mouse.
This operation is implemented by the “Erase XBT-M” command in the “Options”
menu in the message list.

-

Modification

of message

list Size...
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- Transferring the message list
This transfer is only possible if the message list is open and if its size corresponds
to the size of the XBT-M memorycartridge.A partial transfer is possible by selecting
the messages to be transferred.
Transfer is accessed by clicking on the arrow :

There are two possible situations : if the message list uses the default font set, the
messages are sent to and saved by the terminal.
If the message list uses a font set other than the default set, the software suggests
transferring the relevant font set automatically.

Non Standard
Transfer

Font set

Font set

C:WBTLSOOWLSTH.AP~fontl
to the XBTM

.xfn

?

A window showing the various stages of the transfer is displayed. This enables the
user to follow the progress of the transfer and warns him of any problems.
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- Transferring the configuration
To transfer the configuration the message list and the configuration window should
be open. The transfer is initiated by clicking on the arrow.

- Transferring the default messages
If the message numbers are defined in the “Messages displayed by default”
window, these numbers must be transferred to the XBT-M terminal. On the next
power-up these two messages will then be displayed instead of “RUNNING”
appearing on the first line and the time on the second line.
This operation is performed by selecting “Default Messages” in the “Options” menu
in the message list, and by clicking on the “Export” button.

Message

lnitialise

cartridge...

Modification

of message

1

:

l-m-j

I
list Size...

- Adjusting the display unit and the (:lock
The display unit and the date and time of the clock can be adjusted when the XBT-M
terminal is connected to a PC. These adjustments can be made from the
“Configuration” window and are transferred to the XBT-M terminal at the same

time as the configuration.

DISPLAY
Blinking

--

CONFIGURATION

:

:

~~

:

~

Scrolling
Brightness

4djusting and testing the display unit

~

:
0

Iest
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Transferring from XBT-M -> PC (Import)

Transfers can be made from an XBT-M terminal to a PC. A special font set (import
implemented in font set mode) or a message list can be imported.
The message list must be empty and must be the same size or larger than the list
located in the XBT-M terminal.
If the open list is smaller than the message list in the terminal, only a partial transfer
is implemented.

Example :
Size of cartridge in XBT-M terminal : 24 Kb, 600 messages
Size of message list open on PC : 400 messages on a 16 Kb cartridge.
The operator is then warned that only messages 0 to 399 will be transferred.

0 I
l

- Cartridge size 024 Kb [messages 0 to 05991
list size 016 Kb (messages 0 to
0399)

- Message

Import Messages 0000 to 0399 ?

Is also possible for the user to transfer only selected messages. Use the mouse to
select the block of messages to be transferred from the message list, then initiate
the transfer.

Communication error
If there is a problem in communicating with the XBT-M terminal a window is
displayed indicating the cause of the problem. If this happens, the configuration of
the communication link (“Configuration” then “Communication” menu of the main
XST-L900 screen) and the connection of the XBT-M and PC using an XBT-Z915,
905 or 9052 cable should be checked.
The “COM 1 :‘I or “COM 2:” communication ports should also be checked to make
sure they correspond to those in use.
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